
CorelMOSAIC Help Contents
Help topics for CorelMOSAIC are divided into four categories represented by the icons below.
To select a category with the mouse, point to its icon then click. With the keyboard, press Tab to highlight the 
category you want then press ENTER. For more information on using Help, choose the Using Help icon or press F1. To
return to this screen, select the Contents button at the top of the Help window.

    



Restore command (Control menu)
Returns the active window to the size and location it had before you chose the Minimize or 
the Maximize commands from the Control menu.
You can also restore a window by clicking on its Restore button.

· Does not affect a window moved or resized with the Move or Size commands in the 
Control menu.



Move command (Control menu)
Allows you to move the active window with the Direction keys on the keyboard.

· This command is unavailable if the window is maximized.
· You can also use this command to move Application icons and dialog boxes that have a

Control menu.



Size command (Control menu)
Allows you to resize the active window with the Direction keys on the keyboard.

· This command is unavailable if the window is maximized.



Minimize command (Control menu)
Shrinks the active windows to a small icon at the bottom of the screen.

· Using the Minimize command in the Control menu is equivalent to clicking on the 
Minimize button with the mouse.

· You can use the Restore command in the Control menu to restore the minimized 
window to its former size.



Maximize command (Control menu)
Expands the active window to fill the entire screen.

· Using the Maximize command in the Control menu is equivalent to clicking on the 
Maximize button with the mouse.

· You can choose the Restore command in Control menu or click on the Restore button to
return the window to its former size.



Close command (Control menu)
Closes the active window or dialog box. If you have made changes to the current drawing, a 
dialog box appears asking you whether you want to save the drawing.

· Closing Mosaic is the same as choosing Exit from the File menu.
· Double-clicking on the Control Menu box is equivalent to choosing the Close command.



Switch To command (Control menu)
Opens the Task List which lists all the applications currently running on your system.

Dialog Box Options

Switch To
Opens the selected application.

End Task
Closes the selected application.

Cancel
Closes the Task List.

Cascade
Overlaps all open applications so that their Title bars are visible.

Tile
Sizes all open applications to fit on the screen.

Arrange Icons
Arranges the icons of all minimized applications evenly across the bottom of the screen.



Open Directory command (File menu)
Allows you to select a directory containing graphics files for viewing in the file display 
screen. You can also search for specific files by keywords and choose the order (by date or 
size) the images will be displayed in.
If a directory contains older CorelDRAW files and files in unrecognized formats you will see a symbol 
instead of a thumbnail. 

if it's a CorelDRAW file, indicates that the file lacks a thumbnail. You can create a thumbnail by 
importing the file into CorelDRAW and then saving it. Also indicates that a file is a varition of a file format 
which CorelMOSAIC cannot display, for example interlaced GIF.

indicates that the file is in a format that CorelMOSAIC does not recognize. If CorelDRAW 
supports the format, you can still import, export and print the file via CorelDRAW.

Dialog Box Options

File Name
Displays a list of all files in the current directory of a particular file format which can be 
chosen in the List Files of Type box.

Directories
Displays a list of directories for selecting graphics files for viewing. Click on a directory, 
choose OK, and all files of a given format within that directory will be shown in the file 
display screen.
Double-click on a directory to display the related subdirectories and to list all file names 
of a given format in the File Name box. 

List Files of Type
Lists all the file formats available for selection. Click on the arrow button to view the 
range of file types.

Drives
Lists the drives available for selection.

Options >>
Sort by Displays a series of options for organizing your thumbnails in the file display screen. 

You can sort by file name, date, size, or directory name. 

Subdirectories When selected, CorelMOSAIC searches the current directory and all 
directories below it for graphics file names of a specified file format. 
Choose the subdirectories option, click on a directory in the Directories 
box, and click on a file type in the List Files of Type box. Click on OK, and 
all files within the directory and any subdirectories beneath it of a chosen 
file format will be shown in the display screen. 

Preview When selected, shows a thumbnail image of the graphics file highlighted 
in the File Name box.

Keywords Displays the indexing terms associated with a selected CorelDRAW file. 
Notes Displays the annotations associated with a selected CorelDRAW file.
Find Searches a directory for CorelDRAW files that contain specific keywords 

(indexing terms) and displays their thumbnail images in the file display 
screen. See Keyword Search Dialog box.





Keyword Search dialog box
Locates CorelDRAW files that contain specified keywords and displays their thumbnails on 
the file display screen. When a graphics file is saved in CorelDRAW, users may enter terms 
(keywords) that identify the drawing in some way. A graphic of a bouquet of roses, for 
instance, might have the keywords flowers and roses associated with it. 
These keywords are saved along with the drawing and help in locating the images later using 
CorelMOSAIC. To choose files by keywords, select a directory, click on the Find button, and enter the 
keywords to use in your search for files. CorelMOSAIC will then display the CorelDRAW files containing 
those keywords in the display screen.

NOTE: To increase the number of directories CorelMOSAIC searches through, click on the subdirectories 
option before selecting this command. All directories below the selected one will also be searched for files
containing the keywords.

Dialog Box Options

Search Criteria
Type up to four keywords (one per box) to use in the search and link each with either an 
AND or OR command. The AND command will cause CorelMOSAIC to display only those 
files that contain all the specified keywords. The OR command will cause all files 
containing any of the keywords to appear on the file display screen.

Start Search
When selected, CorelMOSAIC will begin to search for files containing the specified 
keywords within the directory. Once found, their thumbnails will be displayed in the file 
display screen.



Print command (File menu)
Opens CorelDRAW and prints the selected graphics files according to the print options you 
specify. If you are printing more than one file, they will all print using the same options.
For Help on using the Print Options dialog box, press F1 once you are in CorelDRAW.



Print Thumbnails command (File menu)
Prints pages of thumbnail images from within CorelMOSAIC. Use the Page Setup command to
select formatting options for the pages.
NOTE: If you are using the Windows Print Manager, make sure you have enough free disk space to store 
the print file that will be created.



Printer Setup command (File menu)
Use this command to select the printer and printer options you want to use to print your 
drawing.

Dialog Box Options

Printer
Selects the default printer or a printer listed in the box under Specific Printer. Only 
installed printers appear in the list. You install printers through the Windows Control 
Panel.

Orientation
Selects the orientation of the printer page.

Paper
Selects the paper size and source. Click on the arrows on the right of the Size and 
Source boxes to see a list of options you can choose.

Options
Displays a dialog box where you can choose default options for the printer you select. For 
more information, choose the Help button after you choose the Options button.



Page Setup command (File menu)
Displays a dialog box for choosing and arranging titles for your printed thumbnails. You have
the option of specifying titles for both the pages and the thumbnails themselves.

Dialog Box Options

Page Titles
Print Title on Adds the titles you
each Page select to each page of printed thumbnails.

Print Directory Prints the name of the
Name directory containing the thumbnails as part of the page title 

information.
Print File Type Prints the name of the file types displayed in the current directory 

as part of the page title information.
Print Page Prints the page number
Numbers as part of the page title information.
Draw Box Puts a frame around
around Page each page of thumbnail images.
Title justification Lists the types of justification(left, right, center) that can be chosen 

for your page titles.
Font Displays a dialog box for changing the appearance of page titles. 

See Font Dialog Box.

File Labels
Print File Name Prints the name of the file under each thumbnail image. To add the 

extension, click on the Include Extension box below this option.

Number of Keywords Prints the number of
to Print keywords you specify below each thumbnail.
Draw Frame Puts a frame around
Around File each thumbnail image on the page.
Font Displays a dialog box for changing the appearance of your labels. See Font 

Dialog Box.



Font dialog box
Changes the appearance of the titles on the pages of printed thumbnails.

Dialog Box Options

Font
Lists the different fonts you can choose for your titles. Click on the arrow button to view 
the range of options or type in a selection,

Font Style
Lists type style options such as bold and italic that can be applied to your titles.

Size
Lists the font sizes in points that can be chosen.

Effects
Strikeout prints a line behind all titles.
Underline prints a line will under all titles.

Color
Lists the colors that can be applied to your page titles. Click on the arrow button to view 
the selection of colors available.

Sample
Displays a sample of text showing all the selected effects.



Preferences command (File menu)
Sets the display format of thumbnail images in the file display screen. You can also select 
operational features, such as confirming the deletion of files, within this dialog box.

Dialog Box Options

Thumbnail Orientation
Portrait Displays thumbnails taller than wide in the file display screen.

Landscape Displays thumbnails wider than tall in the file display screen.
Square Displays thumbnails in standard format in the file display screen.

Thumbnail Width
Changes the    size of the thumbnail images by increasing or decreasing the number of 
pixels. Click on the arrow button to view the range of size options.

Show Thumbnails
When turned off (no check mark), CorelMOSAIC displays file information (file name, size, 
date and time of last modification and location), in place of thumbnails: 

Confirm on File Deletion
When selected, CorelMOSAIC will display a dialog box asking you to confirm the deletion 
of all graphics files within directories and libraries.

Change Font
Displays a dialog box for changing the appearance of thumbnail labels within the file 
display screen. See Font Dialog Box.

Change Color
Allows you to change the color of the background screen. Click on any color in the 
palette. The Define Custom Color option is not operational within CorelMOSAIC.



Font dialog box
Changes the appearance of thumbnail labels on the file display screen.

Dialog Box Options

Font
Lists the different fonts you can choose for your labels. Click on the arrow button to view 
the range of fonts available, or type in a selection.

Font Style
Lists type style options such as bold and italic that can be applied to the labels.

Size
Lists the font sizes in points that can be chosen.

Effects
Strikeout prints a line behind all titles.
Underline prints a line will under all titles.

Color
Displays a list of colors that can be applied to your thumbnail labels.

Sample
Displays a sample of text showing all the selected effects.



Exit command (File menu)
Closes CorelMOSAIC and returns to Windows. If you use the Exit command in the CorelDRAW 
mode, CorelMOSAIC will close and you will return to the CorelDRAW interface.



Select by Keyword command
(Edit menu)
Allows you to locate specific CorelDRAW files in the display screen by entering keywords 
(indexing terms) that are associated with each graphics file. When a graphics file is saved 
within CorelDRAW, users enter terms (keywords) that identify the drawing in some way. A 
graphic of a bouquet of roses, for instance, might have the keywords flowers and roses 
associated with it. 
These keywords are saved along with the drawing and help in locating the images later using 
CorelMOSAIC. After you enter the keywords to use in the search, CorelMOSAIC will highlight the files in 
the display screen that contain the specified terms.

Dialog Box Options

Search Criteria
Type up to four keywords (one per box) to use in the search and link each with either an 
AND or OR command. The AND command will cause CorelMOSAIC to select only those 
files that contain all the selected terms. The OR command will cause all files containing 
any of the chosen terms to be selected in the file display screen.

Start Search
Begins searching for files containing the specified keywords within the selected directory 
(or directories). Once found, the file thumbnails will be highlighted in the file display 
screen.



Select All command (Edit menu)
Selects all thumbnails in the file display screen simultaneously.



Clear All command (Edit menu)
Deselects any selected thumbnails in the file display screen.



Edit command (Edit menu)
Opens a file into one of three applications depending on it's extension.
Extension Application
CDR, EPS, AI, PAT CorelDRAW
SHW or SHB CorelSHOW
BMP, DIB, GIF, PCX (PCC), CorelPHOTO-PAINT
    TGA, TIF

Shortcut
Double-clicking on a thumbnail in the file display screen will also open a file in the 
appropriate application.



Delete command (Edit menu)
Deletes one or more files from the selected directory or library.
NOTE: CorelMOSAIC displays a confirmation dialog box before deleting the selected file(s). You can 
choose not to have this dialog box appear, by choosing Preferences from the File menu and clearing the 
Confirm on File Deletion check box.

Dialog Box Options

Delete File
Shows the name of the currently selected file.

Yes
Deletes the currently selected file. If you selected more than one file, CorelMOSAIC will 
prompt you to confirm each deletion.

Yes to all
Deletes all the selected files without prompting you to confirm each deletion.

No
Skips the currently selected file.



Import into Draw command (Edit menu)
Loads graphics files from CorelMOSAIC into CorelDRAW. You can import files into an existing 
drawing or a new drawing window.

NOTE: Unless you specified differently with the Export Photo CD command, Photo CD images are 
imported in Windows BMP format at 768x512 pixels.



Export From Draw command (Edit menu)
Opens CorelDRAW and allows you to specify an export format for your graphics files. If you 
choose files that are in formats other than CorelDRAW, the files will be imported into the 
CorelDRAW program where you can then specify an export format before the exporting can 
occur.



Get Info command (Edit menu)
Displays a large representation of a graphics file as well as relevant file information. You can 
get information on one or more files by selecting the thumbnails, choosing the Get Info 
command, and stepping through the file information boxes using the Next or Previous 
button. 
You can open the File Information box for a single file by double-clicking on the thumbnail using the 
secondary mouse button

NOTE: The size and color information for graphics created in paint programs such as CorelPHOTO-
PAINT and Windows Paintbrush refers to the original graphics files. The images in the file display screen 
are actually the original graphics files reduced to the same size as the other thumbnails.

The following items are shown in the File Information box:
· Name of the file
· Path: drive and directory
· Date and time of last modification
· Size: width and height (in pixels) of thumbnails
· Colors: color resolution of the thumbnail image (i.e.    8 bits = 256 colors)
· Graphics file size in bytes
· Bitmap image of the selected file
· Keywords associated with the file (CorelDRAW files only) 
· Notes associated with the file (CorelDRAW files only)



Extract text command (Edit menu)
Copies and saves text within CorelDRAW files in ASCII format, so that you can edit the text 
without having to edit the drawing. In CorelDRAW, you can run single or batch (multiple) 
extractions. Once the text has been extracted, you can edit the text files using a word 
processor such as Notepad, then use the Merge-back text function to recombine the text and
graphic image.



Merge-back text command (Edit menu)
Updates CorelDRAW files with text revisions after an Extract text operation has been 
performed.



Keywords command (Edit menu)
Allows you to add or delete keywords (indexing terms) associated with each CorelDRAW file. 
When a graphics file is saved in CorelDRAW, users may enter terms (keywords) that identify 
the drawing. These keywords are saved along with the drawing and help in locating the 
images later with CorelMOSAIC. 
You can change the keywords on one or more graphics files by selecting    the CorelDRAW thumbnails in 
the file display screen, choosing the Keywords command in the Edit menu, and using the Next or 
Previous buttons to step through the different files. 

NOTE: You can not add or delete keywords associated with files that have been compressed into 
libraries.

Dialog Box Options

New Keyword
Box for entering a new keyword that you would like associated with a graphics file.

Current Keyword
Lists all keywords associated with the selected file.

Add
Saves a keyword with the selected graphics file. Type a keyword in the New Keyword 
box and click on the Add button. The new term will appear in the Current Keywords 
box.

Delete
Eliminates a keyword associated with a graphics file.    Click on a keyword in the Current 
Keywords box that you would like to eliminate and click on the Delete button. 

Update All Selected Files
When chosen, makes changes to the keywords of all selected files simultaneously.



Open Library command (Library menu)
Allows you to open an existing library which stores compressed CorelDRAW CDR files.

Dialog Box Options

File Name
Displays a list of all library names in the current directory. Libraries have a CLB extension 
after their filename.    Double-click on a library name and all files within the library will be 
displayed in the file display screen.

Directories
Displays a list of directories for selecting library files to view. Double-clicking on a 
directory will select it, display all related subdirectories, and list all library names in the 
File Name box. 

List files of Type
Lists the library file formats available for selection.

Drives
Lists the drives you can choose from. Click on the arrow to the right of the Drives box to 
view the range of options.



Add Images to Library command
(Library menu)
Allows you to create a new library of graphics files or add selected files to an existing library.
As a general rule of thumb, ensure that there is free space available on your system equal to
the total size of all the files you want to archive. (See Disk Space Requirements for Library 
files.) You can choose images from directories as well as subdirectories. Ensure that no two 
files you choose within subdirectories have the same file name or this may affect the library 
file contents.
NOTE: When libraries are created they consist of two files, one ending in CLB and the other in CLH. 
Ensure that both files are present when you move or save libraries to disk.

Dialog Box Options

File Name
Displays a list of all library names in the current directory. Libraries have a CLB extension 
added to their filename. Click on a library that you would like to add images to, choose 
OK, and all files within that library will be displayed in the file display screen. To create a 
new library, type in a name of your choice in the box above the list of files.

Directories
Displays a list of the directories available for selection. Double-clicking on a directory will 
select it, display all related subdirectories, and list all library names in the File Name 
box. 

List files of Type
Displays Corel Library File as the file type being created.

Drives
Lists the drives you can choose from. Click on the arrow button to view the range of 
options.



Disk Space Requirements for Library files
Whenever you update a library file in CorelMOSAIC, the program makes copies of your 
original library files and then uses these copies for the updates you request. Once the 
updates are complete, the updated files overwrite your original library files to complete the 
process.
If an error (for example, a bad disk sector error) should occur in this final stage, your original library files 
may only be partially overwritten and thereby rendered useless. This is rare, but it can happen. If it does, 
you can use the updated copies located in the directory you specified. (NOTE: If insufficient space exists 
in this directory, CorelMOSAIC will create the updated copies either on your TEMP drive or in your 
Windows directory.)

The copies will have the same names as the original but with .~LB and .~LH extensions. So that 
CorelMOSAIC will recognize the files as library files, you'll need to change the extensions to CLB and 
CLH respectively. 

Using a RAM drive as your TEMP drive
If you're using a RAM drive as your TEMP drive any files--including library files CorelMOSAIC creates--will 
disappear when you turn your computer off or if you're forced to reboot.

If you are building large libraries, this is a good reason not to use RAM for your TEMP drive. Instead, 
assign it a directory on one of your physical drives that has at least several megabytes of free space 
available. You'll also have to change the appropriate entry in your AUTOEXEC.BAT file to let your system 
know exactly where your TEMP drive is.



Expand Images From Library command
(Library menu)
Used to extract and decompress one or more files from a library. When graphics files are 
stored within a library, they are compressed to save room on your hard drive. Before you can
work with images in a library file, they must be expanded and placed in a directory. 
Even if files were initially from different subdirectories, they will be expanded into one directory location. 
Once you have chosen a directory for expanding your files, the program will automatically use this 
directory again for all subsequent expanding tasks, unless you choose another directory later.

Dialog Box Options

Directories
Lists the directories you can choose from to expand your library files. Click on a directory 
for expanding your files, and choose OK. Double-clicking on a directory will display all 
library names within the directory in the box to the right of the Directories box.

Drives
Lists the drives you can choose from. Click on the arrow button to the right of the Drives 
box to view the range of options.

Shortcuts
Double-clicking on the thumbnail of a compressed file displays the Directory To Extract 
Files To dialog box.



Delete Library (Library menu)
Deletes a library from a specified directory.

Dialog Box Options

File Name
Use to select the library file you want to delete. Either type the name of the file, or select 
it from the list.

Directories
Used to select the directory containing the library file you want to delete.

List files of Type
Displays Corel Library File as the file type to be deleted.

Drives
Lists the drives you can choose from. Click on the arrow to the right of the Drives box to 
view the list of drive letters.



Open Photo CD command
(Photo CD menu)
Allows you to view thumbnails of images stored on a Photo CD disk. When you choose the 
command, CorelMOSAIC automatically selects the file (OVERVIEW.PCD) containing the images.
Once displayed, you can select the images and use the Export Photo CD command to convert them to 
other file formats, or the Import into Draw command to import them into CorelDRAW. You can also use 
the Print commands in the File menu to print the images or their thumbnails.

Dialog Box Options

File Name
Displays the OVERVIEW.PCD file containing the Photo CD thumbnail images.

Directories
Used to select the directory containing the OVERVIEW.PCD file you want to open.

List files of Type
Displays Photo CD Overview Pac, the file format Photo CD images are stored in.

Drives
Lists the drives you can choose from. Click on the arrow to the right of the Drives box to 
view the list of drive letters.



Export Photo CD images command
(Photo CD menu)
Displays a dialog box where you can select a format and size for exporting Photo CD images.
Once you've made your selections, choosing OK will display another dialog box so that you 
can specify where you want the exported files stored.

Dialog Box Options

Export File Format
Clicking on the arrow lists the file formats available for selection. The choice of formats 
includes three bitmap formats (BMP, PCX and TIFF) and EPS, a vector format that page 
layout programs such a Ventura Publisher and Aldus PageMaker support. 
NOTE: EPS files CorelMOSAIC exports do not include an image header.

Export File Size
Lets you specify the size at which the image is exported. Click on the arrow to display a 
list of the sizes you can choose from. All images are exported with 24-bit color. 
NOTE: The amount of disk space required to store the image increases with the image 
size. Choosing the largest size, for example, produces a file that's roughly 18 megabytes 
in size. The time required to export the file also increases with image size.      

Shortcut
Double-clicking on a thumbnail exports the image and then opens it in CorelPHOTO-
PAINT. Note, unless you specified differently with this command, the image will be 
exported in Windows BMP format at 768x512 pixels.



Contents command (Help menu)
Displays the opening CorelMOSAIC Help screen. From this screen, you can choose the type of
Help you want. When you are in Help, clicking on the Contents button takes you back to the 
opening screen.

Shortcut
· Pressing F1 displays the CorelMOSAIC Help Contents or a Help topic on an open dialog 

box.
· Pressing SHIFT+F1 then clicking on an active (undimmed) command displays a Help 

topic on that command.



How to use Help command
(Help menu)
Displays topics which explain how to use the online Help system. You can access the same 
information from the Help window by choosing the Using Help button or pressing F1.



Search for Help On command
(Help menu)
Displays the Help Search dialog box where you can enter keywords to search for and go to a 
specific Help topic. The Search dialog box can also be opened by choosing the Search 
button from the Help window.



About CorelMOSAIC command
(Help menu)
Displays a dialog box with information about which version of CorelMOSAIC you are running.



Archiving
The creation of compressed copies of your graphics files into library files. The creation of 
these compressed files does not affect your original graphics files.



ASCII
An acronym for the American Standard for Information Interchange, which is a standard code
for representing characters and non-printable control codes such as carriage returns and 
page breaks.



Bitmap
An image composed of a series of dots (pixels). Paint programs such as Corel PHOTO-PAINT 
generate this type of image. CorelDRAW creates small bitmapped representations of its 
vector-based graphics for use in file management utilities such as CorelMOSAIC.



Direction keys
The arrow keys (¬, ®, , ¯) and the HOME, END, PgUp and PgDn keys on the numeric keypad.



Directory
Like a drawer in a filing cabinet, a directory is part of the structure used to organize files on 
a disk. Directories have names and can have subdirectories existing below them. For 
example, you could create a directory called LOGOS for storing logo designs.    Two possible 
subdirectories beneath LOGOS might be ROUGH and FINAL, for storing your preliminary and 
finished work, respectively.



Double-click
To press and release the primary mouse button twice in quick succession.



Drawing Window
In CorelDRAW, the drawing window is the screen where graphics can be created and 
manipulated.



Drive
A device in a computer that spins disks used to store information. Personal computers 
normally have a fixed disk drive labeled C and one or two floppy disk drives labeled A and B.



Extract text
Command which transfers text from a selected CorelDRAW file into an ASCII text file for 
editing.



File Format
When you save a graphic, it is stored in a particular format by the application. To import a 
graphic into another program, the graphic must be in a format which the other program 
accepts.    CorelMOSAIC recognizes a variety of different graphics file formats including 
CorelDRAW (CDR), CorelCHART (CCH), CorelPHOTO-PAINT (PCX), CorelSHOW (SHW), EPS, and
Adobe Illustrator(AI).



Library
A master file which can store many individual graphics files in compressed format.



Menu bar 
The bar near the top of a window that contains the names of the program menus.



Merge-back text
Command which recombines a revised text file with the original graphic after an Extract Text
operation has been performed.



Pixels
Minuscule dots of color or shade that together form a graphic image. Paint programs such as
Corel PHOTO-PAINT use pixels to build graphics whereas CorelDRAW uses vectors to create 
graphic images. 



Photo CD
A revolutionary process developed by the Eastman Kodak company that converts 35mm film
negatives or slides into digital format and stores them on a compact disc (CD). CorelMOSAIC 
can open Photo CD images and convert them into formats which CorelDRAW, CorelPHOTO-
PAINT and other applications can import.



Point 
A unit of measurement relating to the height of a character. A point equals 1/72 of an inch.



Primary mouse button
Normally the left mouse button. If, however, you've swapped mouse buttons using the 
Windows Control Panel, the right mouse button becomes the primary button.



Secondary mouse button
Normally the right mouse button. If, however, you've swapped mouse buttons using the 
Windows Control Panel, the left mouse button becomes the secondary button.



Thumbnails
Small bitmapped sketches of graphic images created and saved with original drawing files. 
Thumbnails are used within CorelMOSAIC as a way of organizing, displaying, and selecting 
graphics files visually rather than by filename. 



Title bar 
The bar along the top of a Windows application that contains the name of the application, 
the Control menu box and the Maximize and Minimize boxes. In CorelMOSAIC, the Title bar 
also contains the name of an open file.



Window Border
Borders appearing around windows that are less than full size. Dragging the border lets you 
make the window smaller or larger. 

· Drag the    top, bottom, or side border to size the window in one direction only.
· Drag the corner of the border to size the window vertically and horizontally.

With the window less than full size you can also choose Size from the Control menu then use
the arrow keys to size the window.



Control Menu
Restore returns the active window to its former size and location.

Move allows you to use the keyboard to move the active window.

Size allows you to use the keyboard to resize the active window.

Minimize shrinks the active window to an icon.

Maximize enlarges the active window to fill the screen.

Close closes the active window.

Switch To lets you switch among currently open applications.



File Menu
Open Directory allows you to select a directory for viewing files.

Print opens CorelDRAW and prints selected files.

Print Thumbnails prints thumbnail images from within CorelMOSAIC.

Printer Setup sets printer options from within CorelMOSAIC. 

Page Setup allows you to choose the type and placement of titles when printing thumbnail images.

Preferences lets you change the orientation of thumbnail images in the file display screen and set 
user options.

Exit closes CorelMOSAIC and returns to Windows. In the CorelDRAW mode, the Exit 
command would close CorelMOSAIC and return you to CorelDRAW.



Edit Menu
Select by Keyword locates CorelDRAW files in the file display screen that contain specific keywords.

Select All selects all thumbnails in the file display screen simultaneously. 

Clear All deselects all thumbnails in the file display screen.

Edit opens a file in CorelDRAW, CorelPHOTO-PAINT or CorelSHOW (if the file has an 
SHW or SHB extension). Double-clicking on a thumbnail in the file display screen 
will also open the appropriate application and display the file.

Delete eliminates files from a specified directory or library.

Import into Draw loads graphics files into an existing drawing or a new drawing window within 
CorelDRAW.

Export from Draw opens CorelDRAW and allows you to specify an export format for your files.

Get Info displays a larger representation of the graphics file and information such as file size 
and date.

Extract text transfers text from selected CorelDRAW files into ASCII text files for editing. 

Merge-back text updates CorelDRAW files with text revisions after an Extract text operation has been
performed.

Keywords allows you to add or delete keywords that are associated with    CorelDRAW files.



Library Menu
Open Library allows you to select an existing library which contains compressed 

CorelDRAW CDR files for viewing.

Expand Images From Library extracts and decompresses CDR files from library files.

Add Images to Library creates a new library or adds selected files to an existing library.

Delete Library deletes a library from a specified directory.



Photo CD Menu
Open Photo CD allows you to view    Photo CD images in selected directories.
Export Photo CD Images converts Photo CD images into other formats so that they can 

be used in CorelDRAW, CorelPHOTO-PAINT and other applications.



Help Menu
Contents displays the CorelMOSAIC Help Contents.
How to Use Help explains how to use Help.
Search for Help On displays the Search dialog box which lets you find Help information 

using keywords.
About CorelMOSAICdisplays which version of CorelMOSAIC you are using.



CorelMOSAIC Help Contents
To select a category with the mouse, point to a category icon then click. Keyboard users press TAB to highlight the 
category you want, then press ENTER. For more information on using Help, choose the Using Help button or press 
F1. To return to the this screen, select the Contents button at the top of the Help window.

    

 Menu Commands
· Control Menu
· File Menu
· Edit Menu
· Library Menu
· Photo CD Menu
· Help Menu



 How to...
· Get started
· Create a library
· Expand library files
· Edit text within files
· Perform batch operations
· Formatting and printing thumbnail images        
· Import files into CorelDRAW
· Export files
· Search for files
· Resize the CorelMOSAIC window        



 Overview
· What CorelMOSAIC Does
· Modes of Operation
· Getting Started



What CorelMOSAIC Does
CorelMOSAIC is an innovative CorelDRAW application designed to display, organize, and manage your 
graphics files.

Main Features
The File Display Screen
The file display screen shows small bitmapped representations of your graphics files. This 
feature allows you to select files visually rather than by filename only. When you create a 
drawing in a graphics program such as CorelDRAW, image headers are saved along with 
the main image. CorelMOSAIC uses these headers (called thumbnails) to allow you to 
organize and manipulate your graphics files with ease. Graphics files from a variety of 
different file formats can be viewed and managed within CorelMOSAIC.
To help you make full use of the variety of options available within the program, an 
information bar is provided at the bottom of the screen which identifies the purpose of 
each function as you move through the options in the menus. 
Batch Operations
CorelMOSAIC allows you to perform repetitive tasks on multiple graphics files. You can run
batch printing, imports, exports, and extract/merge back text operations. Files can be 
selected for batch operations from within directories as well as libraries.
Library function
You can store graphics files from different drives and directories in a filing system called a
library. CorelMOSAIC automatically compresses all files in a library. Once successfully 
archived, you can then delete the original files which saves valuable space on your hard 
drive for other applications and the files they create.
Formatting and printing thumbnail images
This feature allows you to:
· Arrange the orientation of your thumbnail images in the file display screen using 

the Preferences option.
· Assign titles to pages and thumbnail images using the Page Setup option.
· Specify printer options within CorelMOSAIC using the Printer Setup option.
· Print selected thumbnails from a directory or library of your choice using the Print 

Thumbnails option.



Modes of Operation
You have the option of running CorelMOSAIC in one of two modes:

Standalone Mode accessed by clicking on the CorelMOSAIC icon in the Windows program 
manager.
CorelDRAW Mode accessed by choosing the MOSAIC option from the Open Drawing or 
Import dialog box in CorelDRAW.
The Cancel item on the menu bar appears only in CorelDRAW mode. All other menus (File, 
Edit, Library, Photo CD) are identical to those found in the Standalone mode. 
The following menu commands will be available when you open CorelMOSAIC from within 
CorelDRAW:

· File Menu: Open Directory, Printer Setup, Page Setup, Preferences and Exit
· Edit Menu: Select by Keyword, Select All, Clear All, Edit, Get Info and Import into Draw

(when Mosaic is opened from the Import dialog box)
· Library Menu: Open Library and Add Images to Library (when Mosaic is opened from 

the Open Drawing dialog box)
· Help Menu: all commands



Getting Started
These introductory procedures will get you started using CorelMOSAIC. The first step is learning how to 
select a directory for viewing files in the file display screen. The second step is learning how to select 
thumbnail(s) in the file display screen. Once you have learned these procedures, you can make use of the
variety of file management techniques available through CorelMOSAIC.

To select a directory:
1. Choose the Open Directory command in the File menu. 
2. Choose the type of graphics files that you would like CorelMOSAIC to display by clicking

on a file format in the List files of Type box.
3. Select a disk drive to search for the desired directory.
4. Click on the Options button to choose additional program features.
5. Select a directory containing graphics files by clicking on a directory in the Directories

box and choosing OK. All files within that directory of a given file format will be shown 
in the file display screen. Double-clicking on a directory will show all related 
subdirectories and display the names of each file of a chosen format within the File 
Name box. 

To select thumbnails in the file display screen using a mouse:
1. Position the mouse pointer over a thumbnail image and click on the left button.

· If you want to select additional thumbnail images, move to a second image, hold 
down the CTRL key and click. To deselect individual images, simply click on them 
with the left mouse key.

· If you want to select a series of adjacent files, click on the first file in the series, hold
down the SHIFT key, and click on the last file in the series. The files you selected and
those in between will be highlighted.    

· If you want to select all the thumbnails in the file display screen, choose Select All in
the Edit menu and all thumbnails will be highlighted.

2. Click on either the UP or DOWN arrow on the vertical scroll bar to move through the 
screens of thumbnails. You can also use the PGUP or PGDN keys on the keyboard to 
move to additional screens. 



Creating a library
You can store selected graphics files in a filing system called a library. Your files will be 
stored in compressed format. Once successfully archived, you can delete the original files, 
freeing up space on your hard drive for other applications. As a rule of thumb, ensure that 
there is free space available on your system equal to the total size of all the files you want to
archive.
When libraries are created they consist of two files, one ending in CLB and the other in CLH. 
Ensure that both files are present when you move or save libraries to disk.
IMPORTANT: If you are creating libraries to compress files and save on disk space, 
remember you should only delete files after they have been successfully archived. Test the 
libraries you create to make sure you can successfully expand any of the images it contains 
before deleting your originals.
To create a library:

1. Open a directory containing the files you would like to include in your library.
2. Select the thumbnails in the file display screen. 
3. Choose the Add Images to Library command in the Library menu.
4. Select a directory for your new library by clicking on one in the Directories box. 

Double-clicking on a directory will display all related subdirectories and show all 
libraries within that directory in the File Name box.

5. Type in a library name including the CLB extension in the bar above the File Name 
box. 

6. Choose OK and your library files will automatically be archived to the location you 
specified.



Performing batch operations
CorelMOSAIC allows you to perform specific tasks on consecutive graphics files. You can run 
batch printing, import, export and extract/merge back operations on your graphics files. All 
files that you want to perform the batch operation on must reside on the same drive.
NOTE: Options that you specify for the initial file will apply to all selected files.    
To perform a batch operation:

1. Open a directory containing the files you would like to use.
2. Select thumbnails in the file display screen.
3. Choose one of the batch commands such as Print or Import. CorelDRAW will open, the 

first image will be displayed along with a dialog box allowing you to specify options 
pertaining to the function.

4. Choose OK and all files will be brought into CorelDRAW sequentially and the tasks 
performed.



Editing text within files
You can revise or update text in CorelDRAW graphics files using the Extract text and Merge-
back text commands. You can run single or batch (multiple) operations.

· Extract text command saves text within CorelDRAW files in ASCII format so that you 
can edit the text without editing the graphic file in CorelDRAW.

· Merge-back text command recombines the revised text files with the original image.
NOTE: If you are planning a merge back operation, keep the same name for your text files as
the graphics files, and place all text files in the same directory as your graphics files.
To extract text from CorelDRAW files:

1. Open a directory.
2. Select thumbnails in the file display screen that you would like to extract text from.
3. Choose the Extract text command in the Edit menu. 

CorelDRAW will open and display the first    image along with a dialog box allowing you 
to choose a directory for the extracted files. Once chosen, all files will be opened 
sequentially in CorelDRAW and the text extracted and placed in files identified by a TXT
extension.      

4. Edit the text in a word processor such as NotePad.
To merge back the revised text with the source images:    

1. Select thumbnails in the file display screen that you wish to Merge-back.
2. Choose the Merge-back text command in the Edit menu. 

CorelDRAW will open and display the first image along with a dialog box allowing you 
to specify the directory containing the extracted and revised text files. Once chosen, 
the text files will be recombined with the original images.

3. Save the changes to your graphics files. 
You will be prompted to save the changed files in CorelDRAW before the next merge-
back operation begins.



Expanding library files
Library files contain compressed versions of graphics files. After they've put in a library, you 
can delete the original files to save room on your hard drive. To open files in a library, they 
must be expanded to full size and placed in a directory. 
Even if files are from different subdirectories, they will be expanded in the one directory 
location. Once you have specified a directory for expanding your files, the program will 
automatically use this directory again for all subsequent expanding tasks in a batch 
operation.
To expand library files:

1. Open a library.
2. Select thumbnails in the file display screen that you would like to expand.
3. Choose Expand from the Library menu.
4. Choose a directory for the expanded files from the Directories box. 
5. Choose OK.



Formatting and printing thumbnail Images
You can format and print pages of thumbnails from within CorelMOSAIC. 
To format the page(s):

1. Open a directory or library with images to format.
2. Choose Preferences in the File menu.
3. Choose the options you want.    
4. Choose OK.
5. Choose Page Setup in the File menu.
6. Click on the title options you would like to see accompany your printed images.
7. Choose OK and all pages of printed thumbnail images for this operation will be 

formatted according to the display and title options you originally specified.
To print the thumbnail images:

1. Choose Printer Setup in the File menu.
2. Select the printer options you want.
3. Choose OK.
4. Select thumbnails in the file display screen.
5. Choose Print Thumbnails in the File menu and all selected thumbnails will be printed. 

If no thumbnails are selected, the program will automatically print all thumbnails in the
directory or library.

NOTE: If you are using the Windows Print Manager, make sure you have enough free disk space to store 
the print file that will be created.



Importing files into CorelDRAW
You can import a file(s) from CorelMOSAIC and add it to an existing CorelDRAW graphic or 
begin a new one. If you choose a library or Photo CD file to import, you will be prompted for 
a directory in which to place the expanded file before entering CorelDRAW. You can also 
import a file into CorelDRAW by double-clicking on the thumbnail in the file display screen.
To import files into CorelDRAW:

1. Open a directory or library.
2. Select thumbnails in the file display screen that you would like to import into 

CorelDRAW.
3. Choose Import in the Edit menu and your files will be imported into CorelDRAW. Each 

imported file will consist of a group, making it easy to separate, scale and place in a 
new drawing.



Exporting files
You can save your graphics files in different file formats for use in other applications. If you 
selected a library or Photo CD file for exporting, you will be prompted for a directory in which
to place the expanded file(s) before entering CorelDRAW. 
NOTE: When changing the format of more than one file, the initial format you specified will apply to all 
subsequent files in a batch operation.

To export a graphics file:
1. Open a directory or library.
2. Select thumbnails in the file display screen that you would like to export.
3. Choose the Export command in the Edit menu. 

CorelDRAW will open and you will be prompted to enter the file format you would like 
to change your image files to. (For further instructions on how to convert file formats, 
refer to your CorelDRAW User's Guide.) 



Searching for files 
CorelMOSAIC can locate files using the keywords (indexing terms) that are linked to 
CorelDRAW graphics files. When files are saved in CorelDRAW, keywords can be specified 
and linked with the files, making it easy to locate them using CorelMOSAIC. 
These keywords can be changed with the Keywords command in the Edit Menu. 
CorelMOSAIC can then be used to either locate files that contain chosen keywords by 
selecting those files in the file display screen, or you can cause it to display only those files 
that contain the chosen keywords on screen.
To locate files in the file display screen that contain specified keywords:

1. Open a directory or library
2. Choose the Select by Keyword command in the Edit menu.
3. Type in the keywords you would like to use in the search separated by either AND or 

OR.
The AND command will cause CorelMOSAIC to select only those files that contain all 
the selected keywords. The OR command will    cause all files containing any of the 
chosen keywords to be selected in the file display screen. 

4. Click on the Start Search button and the files containing the chosen keywords will be 
selected in the file display screen.

To display only those files containing specified keywords in the file display screen:
1. Choose the Open Directory command in the File menu.
2. Select a directory that you would like CorelMOSAIC to search. 
2. Click on the Options button within the dialog box.
4. Click on the Find button to begin selecting keywords. 
5. Type in the keywords you would like to use in the search separated by either AND or 

OR. 
The AND command will cause CorelMOSAIC to display only those files that contain all 
the selected keywords. The OR command will cause all files containing any of the 
chosen keywords to be displayed in the file display screen.

6. Click on the Start Search button and the files containing the chosen keywords will be 
displayed in the file display screen.



Resizing the CorelMOSAIC window
You can resize the CorelMOSAIC window so that it takes up more or less space on your 
screen.
To resize the CorelMOSAIC window with the keyboard:

1. If they are not already displayed, click on  to display CorelMOSAIC's window borders.
2. Press ALT+Spacebar then S.
3. Press the Arrow key that corresponds to the side, top or bottom border you want to 
move.
4. Press the Arrow keys to move the border.
5. Press the ENTER key when the window is the size you want.
To resize of the CorelMOSAIC window with the mouse:

1. If they are not already displayed, click on  to display CorelMOSAIC's window borders.
2. Do one of the following:

· Drag the side, top or bottom border to resize the window in one direction.
· Drag a corner of the border to resize the window in horizontally and vertically. 

3. Release the mouse button when the window is the size you want.



Control Menu box 
Located at the left end of the Title bar in the CorelMOSAIC and Help windows. Clicking on the
Control Menu box displays commands for sizing and positioning the window.



Maximize button 
Located in the upper right corner of the CorelMOSAIC and Help windows if they are not fully 
expanded. Clicking on the Maximize button expands the window to fill the entire screen. 
After you expand a window, the button changes to the Restore button . Use this button to 
return the window to its former size.

· You can also maximize a window by choosing Maximize from the Control menu.
· You can also restore a maximized window to its former size by choosing Restore from 

the Control menu.



Menu Bar 
The horizontal bar near the top of the window contains the names of the available pull-down 
menus. Choose the desired menu by clicking on it, or by pressing the ALT key plus the 
underlined character in the menu name. 



Minimize button 
Located in the upper right corner of the CorelMOSAIC and Help windows. Clicking on the 
minimize button shrinks the window to an icon at the bottom of the screen. 

· As an icon, the application stays in memory but its window does not take up space on 
your screen.

· To restore the window, double-click on its icon, or click once on the icon and choose    
Restore from the Control menu.



Restore button 
Located in the upper right corner of the CorelMOSAIC and Help windows. Clicking on the 
Restore button returns the window to its previous size and location. 

· You can also restore a window by choosing Restore from the Control menu.
· Using the Restore button does not affect a window moved or resized with the Move or 

Size commands in the Control menu.



Scroll Bars
Bars along the bottom and right side of the screen used to view portions of a drawing 
outside the current viewing area.

Click on to
An arrow move the current view 10% in selected direction
An elevator move the view by one windowful
On a thumb and drag move the view an arbitrary amount in any direction



Title Bar
Located along the top of the top of a window, the Title Bar displays the name of the program
and the file you are working on. If it is less than full-size dragging the Title Bar moves the 
window.
The Title Bar may contain the following buttons for controlling the window:

 Maximize button
 Minimize button
 Restore button
 Control Menu box



Window Border
Borders appearing around windows that are less than full size. Dragging the border lets you 
make the window smaller or larger. 

· Drag the    top, bottom, or side border to size the window in one direction only.
· Drag the corner of the border to size the window vertically and horizontally.

With the window less than full size you can also choose Size from the Control menu then use
the arrow keys to size the window.



How to...
Resize the CorelMOSAIC window



No Help Available
No help exists for the selected item. Either choose another item or press F1 for index of Help
topics.




